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1. INTRODUCTION

1.1 What is the COMMUTER model?

The COMMUTER model (subsequently referred to as simply “COMMUTER”) is a
spreadsheet-based computer model that estimates the travel and emissions impacts of
transportation air quality programs.  The model is particularly useful for programs that fall
under the EPA’s Voluntary Mobile Source Emission Reduction Programs and for Commuter
Choice Programs.

1.2 Who will use COMMUTER?

EPA and its subcontractor Sierra Research designed COMMUTER for two types of users: 

• Metropolitan Planning Organizations (MPOs) and state Departments of
Transportation (DOTs) who are assessing emissions impacts of various
Transportation Control Measure Strategies.  These impacts can be incorporated into
State Implementation Plan (SIP) analyses.  

• Individual employers who are assessing the likely effectiveness of Commuter Choice
Programs and voluntary programs in general.

MPOs and DOTs can also provide guidance and assistance to employers participating in
voluntary programs on the application of this tool. 

1.3 Why was COMMUTER created?

COMMUTER was designed to help simplify the effort required by air quality planners to
estimate travel and emission effects resulting from Transportation Control Measures.  The
model can also be used to estimate the benefits of site-specific Commuter Choice (employer-
based transportation) programs to assist employers in designing a program appropriate for
them.

The 1990 Clean Air Act Amendments mandated that the EPA and DOT provide guidance on
“the formulation and emission reduction potential of transportation control measures related
to criteria pollutants and their precursors” (Section 108(f)).  In the early 1990s, EPA
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developed a number of tools and guidance documents to assist communities in developing
these measures and taking credit for the resulting emission reductions.  Because the effects of
TCMs on travel activity and emissions can be very complex, the guidance included many
aspects of vehicle operation and other factors that affect emissions.   The guidance documents
were often very detailed and difficult to use.  

COMMUTER consolidates existing TCM guidance, and is based on “state-of- practice”
methodologies and data.  COMMUTER will reduce the time required to calculate the benefits
of regional and employer-based TCMs.  It will also save regional government resources,
since these governments will have less need to develop their own models and tools.

1.4 What Programs can I evaluate with COMMUTER? 

You can use COMMUTER to evaluate these types of programs, either on the regional scale,
or for individual employers:
 

• Transit fare decreases or other incentives that reduce the cost of using transit;

• Transit service improvements (faster or more frequent service);

• Ridesharing programs, in which employers support carpooling and/or vanpooling
through on-site programs, financial incentives, or preferential parking;

• Other actions, such as increased parking charges or cash-out programs, that change
the time and/or cost of traveling by any particular mode;

• Non-motorized (e.g., bicycle and pedestrian) commuting programs; 

• Alternative work schedules, including flex-time, compressed work weeks, and
staggered work hours; and

• Telecommuting.

1.5 What methodology does COMMUTER use?

COMMUTER is broken down into two components: travel impacts and emissions impacts.

The travel impacts component uses a logit mode-choice model referred to as the “pivot point”
approach.  This approach allows you to analyze the effects of several strategies
simultaneously.  Mode choice models have been developed for many cities and regions
nationwide, so you can often use coefficients that have already been developed to reflect local
characteristics.  This component will calculate the impact of the mode share changes from
these programs and translate the mode share changes into changes in trips and vehicle miles
traveled (VMT).  In addition, COMMUTER contains an input option that allows you to enter
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mode share changes directly (such as might be obtained from employee survey data) as an
alternative to the pivot point-based calculation performed internally by the model.

The emissions component is based on EPA’s MOBILE5b model.  MOBILE5b emission
factors were generated and loaded into COMMUTER for several sets of local conditions. 
You can select the conditions most appropriate for your area, and the model will apply the
corresponding emission factors in calculating and outputting emission reduction impacts (in
tons of VOC, CO, and NOx per day).  If you are an experienced MOBILE5b user, you can
also generate your own set of MOBILE5b emission factors (reflecting your exact local
conditions) that can be imported into COMMUTER. 
  

1.6 When can I use COMMUTER, and when should I not use it?

COMMUTER is particularly useful for smaller Transportation Control Measures that will fit
under the context of the Voluntary Measures Policy, and the model can be used for the
purpose of calculating State Implementation Plan (SIP) credit.  The model will not perform as
well for larger programs, particularly those large enough to impact travel speeds throughout
an area.  If your program is likely to significantly impact travel patterns and speed in your
region, you will need to perform a more complete analysis using your regional travel demand
modeling in order to claim SIP credit.  You should consult with your regional EPA office if
you believe your program can have these impacts.  In this case, you can still use
COMMUTER to calculate an initial estimate of a potential program.  You may want to do
this to help you select a program and determine if you want to further consider particular
options.     

In some cases, you may also use COMMUTER to calculate the VMT impacts of projects for
transportation conformity.  You should not use the emissions estimates of the model in this
cases.  Areas that are subject to transportation conformity must estimate the VMT and
emissions impacts of the projects in their transportation plans and transportation
improvement programs.  For projects that are not regionally significant (as defined in 40 CFR
93.101), you may estimate the VMT effects using off-model techniques, in accordance with
reasonable professional practice.  This means you do not need to determine the VMT impacts
of the program using a travel demand network model.  Through the interagency consultation
process, you can discuss whether COMMUTER is an appropriate off-model method to
estimate VMT reductions.  You will still need to combine the estimated VMT impacts of the
program with the impacts of other programs to determine the overall emissions impacts in the
area.

1.7 What do I need to do to get started? 

In order to get the most accurate results with the model, you will need to gather background
information about the travel characteristics in your area. COMMUTER does have data on
national average travel patterns available as default settings. However, using local data will
yield more accurate results.  This greater accuracy is required if COMMUTER results are to
be used as a part of a State Implementation Plan or other regional air quality management 
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IMPORTANT: COMMUTER is not designed to quantify baseline
travel or emissions.  Instead, its purpose is to estimate travel and
emission changes associated with specific measures, based on
inputs you provide.  Thus, although COMMUTER may be used to
calculated SIP credits for these measures, the baseline travel or
emissions estimates it generates will not exactly match your
baseline SIP inventory.

plan.  MPOs or Councils of Government (COGs) generally compile this information for an
area.  Regional COGs are local government organizations designed to study and recommend
solutions to problems facing an individual region and to help their local government
members apply effective, coordinated regional planning.  MPOs are similar organizations that
focus on transportation-related planning.  

If you are an employer or other non-MPO user of this model, you should contact the MPO or
COG in your area.  The National Association of Regional Councils (NARC) maintains an
Internet website at http://www.narc.org.  From the NARC home page, you can access
information about the Association of Metropolitan Planning Organizations (AMPO) and lists
of COG and MPO links by state (http://www.narc.org/links/member.html). If you are unsure
of the appropriate source, you should consult with your regional EPA office to find the
appropriate source of information.  The locations of EPA regional offices can be found at
http://www.epa.gov/epahome/locate2.htm.

You will also need specific background information for your particular program.  This user
manual will assist you in determining the appropriate inputs into the model.  Again, if you
have any further questions, you can consult with your regional EPA office.

1.8 What other documentation is available? 

This user manual presents the key instructions needed for you to effectively develop inputs
and run COMMUTER.  Although it attempts to provide you with enough information to
understand how to develop inputs and operate the model, it is intentionally not exhaustive in
detail.  If you are interested in further understanding the theory behind the modeling
calculations, please consult the companion document to this user manual, “Procedures
Manual for the Analysis of Voluntary Mobile Source Emission Reduction and Commuter
Choice Incentive Programs.”1*  

###



*  The COMMUTER application should also be able to run under Windows NT 4.0, but it has not been
tested under that operating system.
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2.  USING THE MODEL

This section explains how to install COMMUTER and provides a general overview of how to
run each element of the program, as well as how to view and save your results.  Further
details on the type of data required are provided in Section 3 (for general existing condition
inputs), Section 4 (TCM-specific information), and Section 5 (emissions-related
information).

2.1  What type of computer equipment and software do I need?

COMMUTER runs on personal computers using Microsoft’s Windows 95/98 or Windows
NT 3.5/4.0 operating systems.* You must also have Microsoft Excel 95 (i.e., Excel 7.0), 
Excel 97, or Excel 2000 installed.  If your computer allows you to run these programs, you
can use COMMUTER.  (However, if you have a Pentium-class CPU with less than 150 MHz
or a 486 CPU, moving through the input screens may be slow at times.) 

COMMUTER will work at 640 x 480, 800 x 600, and 1,024 x 768 display resolutions at both
250-color and 16-bit (Hi-Color) depths, and should run at any available video display setting.

COMMUTER requires a minimum of 2.5 MB of disk space.  You must also have enough
space for saving data on different scenarios that you want to analyze and if you want to
import locally-generated emission factors into the model.  You should allow 85 KB of disk
space for each scenario that you expect to save and another 500 KB if you plan to import
separate emission factors into the model.  (Further details on saving scenario data and
importing emission factors will be explained in the next section.)

2.2  How do I install and operate COMMUTER?

Installing the Program 

Installing COMMUTER is quite simple.  The model, along with some sample files, is
contained in the COMM1.EXE  self-extracting archive file (which can be downloaded from
EPA’s web site at http://www.epa.gov/otaq/transp.htm).  Step-by-step installation
instructions are given as follows.



*  If the Windows Explorer has been replaced by Internet Explorer (e.g., in Windows 98), Internet Explorer
can be configured to launch programs with a single mouse click instead of a double-click.
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Step 1 - Create a new folder or directory on your computer where you want to install and
operate COMMUTER (e.g., C:\COMMUTER).  (When you run COMMUTER, it can
create and re-use “scenario” files that store your data and assumptions for a particular
analysis case or scenario.  Thus, it is highly recommended that you create a separate
folder for COMMUTER so these files don’t get mixed up with others.)

Step 2 - Download or copy the COMM1.EXE  installation file to the folder or directory
you just created.

Step 3 - Execute the COMM1.EXE  program (e.g., double-click the COMM1.EXE  file
from the Explorer window).  This executable file is a self-extracting compressed archive
that contains following files:

• COMMUTER.XLS  - the COMMUTER program;

• AREAWIDE.VME  - an “area-wide” sample scenario file;

• ONEEMP.VME  - a single-employer sample scenario file;

• USERTMPL.INP  - a sample template input file for creating local MOBILE5b
emission factors for use in COMMUTER; and

• USERTMPL.PRN - a sample MOBILE5b output file for emission factor import into
COMMUTER.

After you have run the COMM1.EXE installation program, the five files listed above
should now appear in your “COMMUTER” folder.  You are now ready to run 
COMMUTER.

Running the Program

Once you have installed the program, there are several different ways that you can run the
program.  These will be familiar to you if you already use Windows 95/98 or Windows NT. 

• Create and launch a shortcut to the application;

• Double-click* the COMMUTER.XLS  file from within the Windows Explorer or
Internet Explorer window (assuming Excel has been installed and associated with
.XLS file types);

• Right-click the COMMUTER.XLS  file and click “Open” from the pop-up menu; or
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Figure 1
COMMUTER Startup Screen

• Click the Start button at the bottom left of Windows 95/98/NT desktop, select
“Documents” from the pop-up menu, and then click the COMMUTER.XLS  file
from the pop-up list of documents.   (This method will work only if you have recently
opened the COMMUTER.XLS  file and it still appears in your “Recent Documents”
list.)

As the program loads, you will see a startup screen like the one shown below in Figure 1.

The startup screen includes an “input legend” showing the colors that are used to identify the
different types of cell ranges that you will see on the data entry screens.  Different colors are
used to identify cells that you type inputs into and to highlight on-screen help boxes as listed
below:

• light green - required input cells;
• yellow - optional input cells;
• white - locked (i.e., non-editable) cells;
• gray - program-controlled cells; and
• red - help text boxes.
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Required inputs must be typed into all light-green cells shown in the edit screens.  You can
also supply inputs in the yellow shaded cells, but the program will run if they are left blank. 
(However, it is a good idea to use these optional input cells to supply more information about
the analysis scenario you are constructing.)  White and gray cells are locked from editing and
are used to display information.  Finally, red cells highlight help boxes containing brief
instructions for the inputs being entered on each screen.

NOTE:  When the program has finished loading, you will see a
“Ready” indicator at the bottom left of the application window. 

The user interface for COMMUTER has been programmed to display on your entire screen
(i.e., in “full” screen).  If you need to temporarily minimize the COMMUTER application to
the Windows taskbar (located at the bottom of the Windows desktop by default), type “Ctrl-
m” (i.e., hold down the Ctrl key and type “m”).  To restore the COMMUTER application to
the full screen, just click its button in the Windows taskbar.  

2.3  How do I begin once the program is installed?

Once the program finishes loading, you can select from four main menus listed at the top of
the screen:  the File menu, the Edit Inputs menu, the Results menu, and the Help menu. 
These menus will be available at the start of every session, and will allow you to enter data
(Edit Inputs menu), view results (Results menu), print results (File menu), get help (Help
menu), and retrieve or save data and results for a specific analysis (referred to as a “scenario”,
accessed through the File Menu).  

Figure 2 shows the structure of the main menu, which includes the “File,” “Edit Inputs,”
“Results,” and “Help” menus, and each of the sub-menu elements. 

You will generally begin an analysis by clicking through the data entry elements in the Edit
Inputs menu in the order in which they are listed in the menu.  (Once you have defined an
analysis, you can later load and edit a scenario from the File menu; this will be discussed later
in Section 2.6.)  Each of the elements in the Edit Inputs menu corresponds to the input
screens for entering specific data required by COMMUTER.  (Detailed information on the
data required for these screens is provided in Sections 3-5.)
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File Menu Edit Inputs Menu

Results Menu Help Menu

Figure 2
Menu Structure

When the program is first loaded, some of the sub-menu elements shown in the Edit Inputs
menu will be shown as gray shaded-out text, which indicates that you have not yet selected
any TCM programs for analysis.  (As explained below, you will make these selections by
using the check boxes at the bottom of the Scenario Information screen.)

2.4  How do I input data?

The Edit Inputs menu lists each of the input screens available.  Some of the screens are for
inputting baseline (i.e., existing condition) information needed regardless of the type of TCM
being analyzed; others will be used only when analyzing a particular measure. 
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IMPORTANT:  The program will automatically size the width of
the data entry screens to the width of your monitor.  However, the
length of some of the screens will exceed the monitor’s vertical
display dimension.  Therefore, for some input screens (such as the
Scenario Information and Local Data screens), you must scroll to
the bottom of the screen to complete the data entry required in that
screen by using the vertical scroll bar or the “Down Arrow” or
“Page Down” keys.

The information that must be entered in each input screen is listed in Table 1.  The data
required in the first three screens (“Scenario Information,” “Local Data,” and “Edit
Coefficients”) consist of general information, background travel data, and mode-choice
coefficients.  

Table 1
Summary of COMMUTER Data Inputs

Input Screen Data Required

Scenario Information
General information, including area size and scope (i.e., regional vs. site-
specific) being analyzed and the TCM programs being evaluated

Local Data
Background travel data such as existing mode shares, trip lengths,
occupancy levels, baseline vehicle miles traveled, baseline speeds, and
option to provide final mode shares (after TCMs)

Edit Coefficients
Provides default mode choice coefficients as a function of the area size
entered earlier and for selected cities, which can be edited by the user

Site Access & Transit
Service Improvements

Data required for analysis of either site access or transit service
improvement TCMs, including changes in site access walk times and
employer participation rates, and transit headway and route travel time
changes 

Financial Incentives &
Parking Costs

Inputs for analysis of financial and parking incentive programs consisting
of changes in parking, transit fare, or other costs by travel mode

Site-Specific Employer
Support Programs

Parameters that specify either the program participation level or expected
mode share increase resulting from the implementation of an employer
(i.e., site) specific commuter choice program

Area-Wide Employer
Support Programs

Employer participation level inputs required for area-wide analysis of
commuter choice programs being implemented across a metropolitan area  
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Alternative Work
Schedules

Existing and expected eligibility or participation rates for alternative work
schedule programs being evaluated, such as flex time, compressed work
weeks, staggered hours, and telecommuting

Fleet Emissions
Information

Inputs required by the program in order to either apply a pre-generated set
of MOBILE5b fleet emission factors or to utilize locally generated
MOBILE5b emission factors imported into the model

Other Emissions-Related
Data

Fleet travel mix (e.g., fraction of travel by vehicle class) and start fraction
inputs required by the program to calculate TCM emission reductions that
are specific to the local conditions being modeled 

If you have not yet done any analyses or want to analyze a new scenario, you will start with
the Scenario Information screen to enter general background information and to select the
type(s) of TCM programs being evaluated.  This selection is made by checking the
appropriate boxes shown at the bottom of the Scenario Information screen.  You can enter
any non-blank character in the check boxes to activate analysis of the specific TCMs.  

Travel data should be entered using the Local Data screen, and you can use the Edit
Coefficients screen to edit the default mode choice coefficients provided with the 
program.  (Images of these screens and details on the data required are provided in Section 3.) 
By default, COMMUTER calculates changes in mode share due to the types and extent of
specific TCM programs being modeled.  If , however, you have estimates of changes in mode
share due to modeled programs, you can optionally enter the final mode shares (resulting
from changes to existing shares) in the Local Data screen.

Data for the specific TCM program(s) being evaluated are entered in the next five screens. 
You will have access to only those screens that were selected (checked off) for analysis in the
Scenario Information screen.   Detailed information on these screens is provided in Section
4.

NOTE: If you have chosen to enter your own final mode share
estimates in the Local Data screen, you do not need to enter
information in any of the TCM-specific program screens.  In this
case, the inputs in these screens are bypassed and the final mode
shares you have entered are used to compute VMT and trip impacts.
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Finally, you will enter emission-related data in the last two data screens (addressed in
Section 5).  This will include either vehicle fleet parameters that allow the program to find
and apply a specific set of previously generated MOBILE5b emission factors that
approximate local conditions being modeled, or selection of MOBILE5b emission factors
that you have generated to more precisely reflect local conditions.

NOTE:  You may see a “Calculate” annunciator on the status bar
at the bottom of the application window while you are entering
data.  This is normal.  During data entry, the program recalculates
only specific portions of the underlying spreadsheets in order to
speed up performance.  Later, when you view or print results or
save the scenario data, all underlying sheets are recalculated.

If you are only interested in computing travel impacts, you do not need to enter any
emissions-related inputs in these last two screens.

2.5  Is there help available when inputting data?

From the Help menu, you can view a “Model Layout” screen that provides an overview of the
layout and data flow of COMMUTER.  The Model Layout screen also identifies the input
screens that apply to specific voluntary measures and commuter choice programs.  Figure 3
shows the Model Layout screen.  Note that on smaller monitors, you may need to scroll down
to view the entire screen.

You can also return to the Startup screen from the Help menu.  (This is handy if you need to
refer to the cell coloring conventions used to guide you in entering model inputs.)

In addition, many of the input screens offer additional guidance on the specific data that must
be entered.  In some screens, explanatory notes are shown next to the input cell.  In other
screens, “help boxes” displayed with light red backgrounds provide more extensive
descriptions of key data inputs.

Once you’ve finished inputting all the required data for each screen (remember that in some
cases you may need to scroll down your screen to complete data entry), that screen will
appear with a checkmark (7) beside it the next time the Edit Inputs menu is accessed.  You
can use the presence or absence of checkmarks as an easy visual reference of additional data
that must still be entered.
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2.6  Can I save my inputs to use in another analysis?

Saving Scenarios - To make repeated use of COMMUTER quicker and easier, you can save a
complete set of analysis inputs and re-use them later as a template for evaluating other
scenarios.  This avoids having to type in complete data from scratch for each analysis, but
still allows you to modify selected data to evaluate alternatives.

After inputting data for a specific analysis case, save the information to a “scenario file”
(indicated by a “.VME” file extension).  First click on the “File” menu and select “Save
Scenario.”  This will bring up a dialog box that allows you to save the file to disk for later
use.  Click the arrow to the right of the “Save in” box to select the directory where you want
to save the file, then type a file name for the scenario to be saved in the “File name” box,
using the .VME suffix.  

Loading Saved Scenarios - When you want to load and re-use a saved scenario file,  click the
“L oad Scenario” item from the File menu.  Then, select the directory and the specific
scenario file you saved earlier to be loaded into the application.  Re-using existing scenarios
and making minor changes to their inputs is a more efficient way to create a series of related
scenarios than typing in all the data for each scenario.
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COMMUTER MODEL DATA LAYOUT
(SCROLL DOWN TO VIEW ENTIRE LAYOUT SCREEN)

GENERAL INPUT SCREENS

SCENARIO INFORMATION LOCAL DATA MODE CHOICE MODEL COEFFICIENTS
General Information   Existing Mode Shares Choice of:
Analysis Area Definition   Existing Trip Length    Defaults by Area Size
Analysis Area Employment   Existing Occupancy    City-Specific Defaults
TCM Programs Being Analyzed   Peak Period Info    User-Specified

  Observed Mode Shifts
  from TCMs (optional)

TCM PROGRAM-RELATED INPUT SCREENS

SITE-SPECIFIC PROGRAMS AREA-WIDE PROGRAMS

SITE ACCESS IMPROVEMENTS (NO TRANSIT) SITE ACCESS & TRANSIT SERVICE IMPROVEMENTS
Preferential Parking Preferential Parking
Bicycle Lockers Bicycle Lockers
New Transit Stops New Transit Stops

More Frequent Transit Service
Faster Transit Service

FINANCIAL INCENTIVES & PARKING COSTS FINANCIAL INCENTIVES & PARKING COSTS
Parking Cash-Out Parking Cash-Out
Differential Parking Charges Differential Parking Charges
Transit Incentives Transit Incentives

SITE-SPECIFIC EMPLOYER SUPPORT PROGRAMS AREA-WIDE EMPLOYER SUPPORT PROGRAMS
On-site Transportation Coordinator On-site Transportation Coordinator
Ridematching Ridematching
Outreach and Promotion to Employees Outreach and Promotion to Employees

Outreach and Promotion to Employers

ALTERNATIVE WORK SCHEDULES ALTERNATIVE WORK SCHEDULES
Flex-time Flex-time
Compressed Schedules Compressed Schedules
Staggered Hours Staggered Hours
Telework Telework

EMISSIONS-RELATED INPUT SCREENS

FLEET EMISSIONS INFORMATION (Optional) OTHER EMISSIONS-RELATED DATA (Optional)
  Inputs for Pre-Loaded MOBILE Factors   Vehicle Fleet Mix
  Inputs for User-Supplied MOBILE Factors   Affected Vehicle Speeds

  Cold Start Percentages

RESULTS SCREEN

RESULTS
Mode Shares & Changes
Trip Changes
VMT Changes
Emission Reductions:

HC (as VOCs)
CO
NOx
CO2

Figure 3
Model Layout Screen

Clearing Scenarios - If for some reason you have loaded a scenario or have typed in data for
all the input cells and want to delete the data from all the input cells and start over, you can
click the “Clear Scenario” item on the File menu.  This initializes the program by erasing the
data currently contained in the input cells if you want to start re-entering all new data without
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having to exit and reload COMMUTER.  It does not delete saved scenario files from your
hard disk.

2.7 Can I use my own emission factors?

COMMUTER has been pre-loaded with 24 sets of MOBILE5b emission factors that
encompass a range of input conditions reflecting “typical” summer and winter conditions
throughout the country.  Each of these pre-loaded sets contains emission factors for five
specific calendar years: 2000, 2002, 2005, 2010, and 2020.  Under general circumstances
when COMMUTER is used as a screening model, selecting the set of pre-loaded emission
factors that best matches your local conditions is adequate.  However, if you want to use
COMMUTER to produce SIP-consistent emission reductions and are an experienced
MOBILE5b user, you can use your own locally generated MOBILE5b emission factors to
calculate emission reductions in COMMUTER.  The steps for using your own emission
factors are explained below.

Step 1 - Create Properly Formatted Emission Factor Output File - Although you can
specify your exact local input conditions, your MOBILE5b output emission factors must
be generated in a specific format expected by COMMUTER.  The sample MOBILE5b
template input file USERTMPL.INP , which was installed in your “COMMUTER”
directory, identifies how specific program control flags in the MOBILE5b input file must
be set to produce output emission factors in this COMMUTER-required format.  In
addition, it contains a series of 55 “Scenario Descriptive” records that produce emission
factors over a range of speeds and operating mode fractions expected by COMMUTER. 
These scenario records can be edited to reflect the altitude, calendar year, local ambient
temperature and season of interest.  However, if you change the speed or operating mode
input values in these scenario records, the resulting output emission factors will not work
properly with COMMUTER.

IMPORTANT: Once you’ve edited the 55 scenario records to
reflect your own altitude, temperature, and season inputs, you can
copy and paste this block of records to create emission factors for
multiple calendar years.

Depending on your local conditions, you may also need to create additional scenario
records, inserting one after each of the 55 Scenario Descriptive records, to model a Low-
Emission Vehicles (LEV) program.

You cannot assemble a series of separate MOBILE5b emission factor runs in a single
input file (e.g., containing separate sets of program control flag and scenario records). 
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Although this is allowed by MOBILE5b, these types of embedded runs cannot be read
correctly by COMMUTER.  If you need to model different sets of local conditions (e.g.,
two levels of an inspection and maintenance program), you will need to create a separate
MOBILE5b input file.

Once you have set up your MOBILE5b input file as described above and in accordance
with the required program control flag values listed in the USERTMPL.INP  file, run
MOBILE5b.  You can name the MOBILE5b input and output files as you choose.

Step 2 - Import Emission Factors - Once you’ve created your properly formatted
MOBILE5b emission factor output file(s), they can be imported into COMMUTER.  This
is done by clicking “Import Emission Factors” from the File menu.  A window will be
displayed that allows you to point to and open a specific file.  You will then choose the
output, or .PRN file resulting from running MOBILE5b with the input file you created.  It
may take a minute of two for COMMUTER to incorporate the new output file into its
data structure.  A message will appear telling you the file has been successfully copied
when it is done.  If you have not set up your input file formatting properly as described in
Step 1, an error message will be displayed when you try to import the resulting
MOBILE5b output file.  In this case, carefully check and edit your MOBILE5b input file
in accordance with the guidance in Step 1 and re-run MOBILE5b.

Step 3 - Activate User-Supplied Emission Factors Option - After you’ve successfully
imported your own emission factors into COMMUTER, you can direct the model to use
them in the emission reduction calculations by marking the “User-Supplied Emission
Factors” box (with an “X”) near the bottom of the “Fleet Emissions Information” screen
and entering the specific calendar year of interest below that box.  (Further details on
information entered in the Fleet Emissions Information screen are provided in Section
5.1.)

Once you have imported your own emission factors into COMMUTER, they are internally
saved and made available each time you launch the COMMUTER program or until you
import a different set of factors as described in Step 2 above.  If you import a set of emission
factors for a large number of calendar years (e.g., each year from 2000 to 2020), the size of
the COMMUTER program will become much larger than 2.5 MB.  If you are short on disk
space, the “Empty Emission Factors” command from the File menu can be used to delete
your internally stored local emission factors until you need to use them again.  (At that time,
you can simply re-import them.)

2.8  How do I view the results?

Once you have provided all of the required inputs (or selected default values), COMMUTER
will automatically calculate TCM travel impacts and, if you’ve entered emission factor
inputs, emission reductions.  To view the results, all you need to do is simply click either of
the two command items on the Results menu.  “View Travel Results” displays travel impacts
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only.  “View Travel and Emission Results” shows both travel impacts and emission
reductions (assuming you’ve entered emission factor inputs). You can then scroll down the
tabular summary to see the calculated results.  Key outputs include the following:

• Baseline and final mode shares for each mode, including percent of trips eliminated
and change in mode share (final minus baseline);

• Percent of trips shifted from the peak to off-peak period;

• Baseline and final peak, off-peak and daily VMT;

• Baseline and final peak, off-peak and daily vehicle trips; and

• Change in total daily emissions for each criteria pollutant, HC (as VOC), CO and
NOx (in tons) and CO2 (in metric tons).

NOTE:  If you did not enter all of the necessary input data, an
“Incomplete or Inconsistent Input” message box will be displayed
when the View Travel Results or View Travel and Emission Results
buttons are clicked.  The message box indicates which data must
still be entered.  If you click the OK button in the message box, the
program will activate the first entry screen and cell for which
missing or invalid data were detected.

To return to an input screen after viewing the results calculated by COMMUTER, simply
click the appropriate item in the Edit Inputs menu at the top of the application window.

2.9  How do I print my data and results?

For each scenario you evaluate, you can print both the detailed input data and the tabulated
emission reductions.  To do this, click the File menu.  Then select “Print Inputs” from the
drop-down menu to print a detailed listing of all program inputs.   Select either “Print Travel
Results” or “Print Travel and Emission Results” from the File menu to print a one-page
output report showing travel impacts or travel impacts and emission reductions, respectively.

Figure 4 shows the layout of a sample output report.  General scenario information and the
specific TCMs evaluated are listed at the top of the report.  Included in these items are boxes
that indicate whether you have supplied your own final mode shares and emission factors. 
Below these items, summaries of the combined mode share impacts and travel and emission
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**  1 metric ton = 2,205 lbs.
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COMMUTER MODEL RESULTS

SCENARIO INFORMATION PROGRAMS EVALUATED

Description Area-Wide Example Scenario X  Site Walk Access Improvements
Scenario Filename AREAWIDE.VME X  Transit Service Improvements
Emission Factor File X  Financial Incentives
Performing Agency EPA X  Employer Support Programs
Analyst John Doe X  Alternative Work Schedules
Metropolitan Area Anywhere, USA
Area Size 1 - Large (over 2 million)
Analysis Scope 1 - Area-Wide (e.g., MSA, county)  User-Supplied Final Mode Shares
Analysis Area/Site Downtown
Total Employment 300,000

MODE SHARE IMPACTS TRAVEL IMPACTS (relative to affected employment)

Mode Baseline Final %Change Quantity Peak Off-Peak Total
Drive Alone 75.4% 71.8% -3.6% Baseline VMT 3,565,457 2,241,476 5,806,934
Carpool 13.2% 14.3% +1.0% Final VMT 3,419,176 2,188,857 5,608,033
Vanpool 0.5% 0.8% +0.3% VMT Reduction 146,281 52,619 198,900
Transit 5.3% 6.3% +1.1% % VMT Reduction 4.1% 2.3% 3.4%
Bicycle 0.4% 0.5% +0.1%
Pedestrian 4.0% 4.3% +0.3% Baseline Trips 300,044 188,627 488,672
Other 1.1% 1.2% +0.1% Final Trips 286,334 183,695 470,029
No Trip -   0.8% +0.8% Trip Reduction 13,711 4,932 18,643
Total 100.0% 100.0% -   % Trip Reduction 4.6% 2.6% 3.8%

Shifted from Peak to Off-Peak 0.5%

EMISSION REDUCTIONS (tons/day except CO2 in metric tons/day, positive values are decreases)

Pollutant Peak Off-Peak Total
HC 0.139 0.044 0.183
CO 1.214 0.371 1.585
NOx 0.221 0.084 0.305
CO2 60.3 20.7 81.0

Figure 4
Sample Output Report

reductions from baseline levels for all the TCMs selected are presented.  As noted in the table
headers, travel and emission reductions are shown as positive numbers.

Again, note that the output units for the emission reductions are different.  HC, CO, and NOx
reductions are given in (short*) tons per day; CO2 reductions are in metric**  tons per day.
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CAUTION: The program allows you to set up a scenario and
produce results for an individual TCM (as opposed to a
combination of measures).  However, summing the results for
measures evaluated individually will not give you an accurate
representation of the true impact of a combination of measures.

2.10  Can I tell the model to remember where my files are stored?

Depending on how you launch COMMUTER (see Section 2.2), your “default” directory (the
directory pointed to when you open or save files) may not be the same as the directory that
the model and scenario files are stored in.  You can tell the model where to look for your
scenario (and emission factor) files so you don’t have to click out of the “system” default
directory (e.g., C:\My Documents) each time you want to open or save a scenario.  

To set your default or “working” directory when you’re running COMMUTER, click “Set
Working Directory” from the File menu.  The first time you do this, COMMUTER will
report that the working directory is blank as shown below.

This is normal.  Simply click the “Yes” button.  Another window, shown below, will be
displayed that then allows you to enter the disk drive and directory path where you’ve
installed COMMUTER (e.g., C:\COMMUTER).
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Once you have set the working directory, COMMUTER remembers that location and uses it
each time you open or save scenario files or import your own emission factors, even if you
exit and then re-run the model.

2.11  What do I do when I’m finished?

Before exiting COMMUTER, be sure you have saved the current inputs in a scenario file, as
described above, if you plan to re-use them later.  When you have completed your analysis
session and want to exit COMMUTER, click “Exit Program” from the File menu.  The
application will then close and exit. 

###
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3.  GENERAL INPUT SCREENS

This and the following two sections guide you step-by-step through the data that must be
provided in each of the input screens.  This section covers the first three screens, which you
use to input general information; Section 4 explains the five input screens that are specific to
individual TCMs being analyzed; and Section 5 discusses the two screens you will use to
enter information required to calculate emission reductions.  Each subsection within these
sections corresponds to one of the program’s ten input screens.  These have been ordered in
the sequence in which you would generally enter data for an analysis.  To make it easier to
find information on specific data inputs, fields have been noted in bold, underlined text.

3.1  Scenario Information

Scenario information describes the area you are analyzing and the broad types of commuter
choice programs to be analyzed.  Figure 5 displays the layout of the Scenario Information
screen.  Key data items are explained below.

Metropolitan Area Size - This is where you define the size of the metropolitan area you are
analyzing, using the following categories:

& Large - more than 2,000,000 in population;
& Medium - 750,000 to 2,000,000 in population; and
& Small - less than 750,000 in population.

Based on the area size you select, the program will retrieve default mode-choice model
coefficients.  Coefficients have also been developed for selected individual cities and are
more accurate than the default coefficients. As discussed later in Section 3.3, you have the
option to override the area size default mode choice coefficients in the “Edit Coefficients”
screen with either the city-specific defaults supplied in the program or updated values you
obtain for your city.

Analysis Scope - The actual analysis can apply to any geographic level.  However, you must
define the scope of your analysis as being area-wide (“1”) or site-specific (“2”). 
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SCENARIO INFORMATION

Field Data Notes

Scenario Information
Scenario Filename Filename of scenario stored on disk
User EFs Filename User-supplied MOBILE emission factors (if used)

Description Title to further identify the scenario (optional)

General Information
Performing Agency Name of your organization (optional)
Address Address of your organization (optional)
Analyst Your name (optional)
Metropolitan Area Name of city/area being modeled (optional)

Metropolitan Area Size
1 = Large (Over 2 million)  2 = Medium (750,000 
to 2 million)  3 = Small (Under 750,000)

Definition of Analysis Area

Analysis Scope 
1 = Area-Wide (Metropolitan Area, County, etc)  
2 = Site or Employer-Based

Analysis Area/Site Name of analysis area evaluated (optional)

Analysis Area Type
1 = CBD (Central Business District)  2 = Other 
High-Density Commercial  3 = Other 

Employment in Analysis Area

Office Employment
Refers to "traditional" professional office space 
employment

Non-Office Employment
Manufacturing, warehousing, retail, medical, 
educational, entertainment and other 
employment-generating land uses

Total Employment                                                      -   

Programs (Mark All Programs Being Analyzed with an "X")

  1.  Site Walk Access Improvements 
Includes preferential parking, improved access to 
transit

  2.  Transit Service Improvements
Includes more frequent and/or faster transit 
service

  3.  Financial Incentives
Includes parking costs, transit fare/pass 
subsidies, or other financial incentives

  4.  Employer Support Programs
Includes support programs for carpooling, 
vanpooling, transit, and/or bicycling

  5.  Alternative Work Schedules
Includes flex time, telecommuting, staggered 
work hours, and/or compressed work weeks

The COMMUTER model may generate abnormally large mode shifts under a regional or area-wide analysis 
scenario if realistic limits are not applied in estimating the affected employment input above.  For site-specific 
analysis, enter the employment of the workplace being analyzed.  For area-wide analysis, the user is encouraged to 
consult Section 3.1 of the COMMUTER Model User Manual for more detailed guidance on estimating affected 
employment inputs for region being modeled.

Metropolitan Area Size is a required input.  The program retrieves default mode choice model coefficients for the 
area size input by the user.  However, these defaults for Large, Medium and Small metropolitan areas are not as 
accurate as the coefficients developed for individual cities that are displayed in Tables A-1, A-2 and A-3 in the 
appendix to the COMMUTER Model User Manual.  These default mode coefficients can be overridden in the "Edit 
Coefficients" screen and the user is encouraged to refer to these tables and to use local coefficients for the specific 
city being modeled.  See the help box in the Edit Coefficients screen and the COMMUTER Model User Manual for 
additional guidance on supplying local model coefficients.

The COMMUTER model can be used to evaluate commuter choice programs on both an urban area-wide and 
individual employer (or site-specific) basis.  The Analysis Scope input controls whether the model calculates area-
wide or site-specific impacts of commuter choice programs.

Figure 5
Scenario Information Input Screen
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An area-wide analysis evaluates TCM programs for a geographic area such as traffic
corridors, subareas (for example, the central business district), activity centers (for example, a
large office park complex), or the entire metropolitan region.  A site-specific analysis
evaluates TCM programs applied only to a single business or employer location.  This option
can be used when considering either a single place of business for a given employer or a
mixed use or multi-purpose place of business for a given employer or employers.  If you are
an individual employer using this model to evaluate a company employer support program,
you should use the “site-specific” analysis.

As discussed in Sections 4.3 and 4.4, you will later be asked for further data that are related
to the scope you select.  For example, if you specify “area-wide,” some screens will ask you
to specify the percentage of employers in the area participating in the program.  If  “site-
specific” is specified, this percentage will be assumed to be 100 percent.  (See Sections 4.3
and 4.4 for detailed instructions for inputting data for both area-wide and site-specific
analysis.)

Affected Employment in Analysis Area - The impact or applicability of various programs
and strategies is affected by type of employees in an area, which COMMUTER defines
according to the land use category of the employer.  “Office” employees are those working in
land use categories that include traditional professional office space.  “Non-office”
employees include those working in manufacturing, warehousing, retail, medical,
educational, entertainment, and other employment-generating land use activities. 
You will be asked to enter both the number of office and non-office employees in the area or
at the target site that can be affected by the TCM programs being modeled.  “Affected” is the
keyword in understanding what employment levels you should input here and  depends on
whether you are performing a site-specific or area-wide analysis, as explained below.

Site-Specific Affected Employment - If you are performing a site-specific or “single
employer” analysis (specified by choosing “2” for Analysis Scope), the employment levels
you enter should be the total of all employees that are eligible for, or exposed to, any or all of
the TCM programs you are evaluating.  Most of the time, site-specific affected employment
will be the total employment level at the site.  In rare cases where employer support, financial
incentive, or alternate work schedule programs being evaluated would only be made available
to a portion of all employees, enter that portion as the affected employment.

Area-Wide Affected Employment - In an area-wide analysis, affected employment should not
be entered as the total employment in the area being considered.  You must estimate that
subset of the total area employment that will be potentially affected by any or all of the
specific TCM programs you are evaluating.
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CAUTION:  For area-wide analysis, you should not enter the total
employment in the analysis area.  You do not want to base the
analysis on the total employment in the analysis area because
COMMUTER will then generate unrealistically high results for
regional scenarios.  For example, the number of trips being shifted
from one mode of travel to another if all employees for a given
region are assumed to participate in a voluntary program would be
too high.

Steps to help you calculate the number of employees that can be affected by the TCM
programs you are evaluating under an area-wide analysis are listed below.

1. First, identify the portion of regional employers (and number of employees) that are
currently participating in existing programs, and therefore should be excluded from the
analysis.  You can obtain the percentages of employers (by size and type) from the MPO
responsible for transportation and emissions planning in the region.  Using the total
number of employees for a region is not realistic.

2. Finally, determine that portion of employers of a specific size (based on their number of
employees) that will be subjected to, or encouraged to implement, the voluntary programs
being evaluated.  This percentage will vary by MPO region and could include either
office or non-office employers with 1,000, 500, 250, or 100 employees.  

3. Next, estimate the portion of employers of each type (office and non-office) who will
agree to participate in any of the TCM programs you are evaluating, which will largely be
voluntary in nature.  This percentage will vary by MPO region and could include office
employers only or a combination of office and non-office employers. 

The following example is provided to demonstrate how you should use this process to
determine the employment levels you need to enter under an area-wide analysis.

Assume total employees for Region X: 1,000,000 employees

1. Estimate portion of total employees currently
participating in existing TCM programs: 20% -200,000 employees

800,000 employees

2. Estimate portion of remaining employees by size of 
employer targeted by your voluntary programs, using
employers of 500+ employees in this example:

Office (500+ employers): 250,000 employees
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Non-office (500+ employers): 50,000 employees

3. Determine portion of remaining employees based on
estimated percentage of employers willing to 
participate in any of the modeled programs:

(In this example we’ll assume 30% office and 
10% non-office employer participation)

Office - 30% participation: 75,000 employees
Non-Office - 10% participation: 5,000 employees

Using this example, you would enter inputs of 75,000 and 5,000 employees for affected
office and non-office employment, respectively.

You should be careful in making assumptions about the number of affected employees in
each region.  Each region is likely to be significantly different based on the current
participation in voluntary programs, employer and employee participation rates, and regional
employment characteristics.

As these steps and the example indicate, when inputting the “affected” employment under an
area-wide analysis, you should supply estimates of the number of office and non-office
employees that are eligible for participation in any of the specific TCM programs you are
evaluating.  

NOTE: If you are evaluating a scenario that packages multiple
programs (e.g., site access improvements, transit improvements,
and financial incentives), individual “program” participation rates
can also be specified in subsequent input screens for each program.
You should not confuse these program-specific participation rates
with the employer participation percentage in any program used to
estimate affected employment inputs.  The program-specific
participation rates in subsequently discussed input screens provide
you with a means to “weight” the participation of all affected
employees within individual programs when analyzing scenarios
that combine multiple programs.

Programs - In this section, you simply check off which types of TCM strategies or programs
are to be considered in the scenario being analyzed.  There are five possible choices,
described below.  You simply mark (with an “X”) all of the programs being analyzed; you do
not have to select only one.
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1. Site Walk Access Improvements - Includes preferential parking for employees using
carpool and/or vanpool programs and improved access to transit systems.

2. Transit Service Improvements - Includes more frequent and/or faster transit service.

3. Financial Incentives - Includes any project or program that changes the out-of-pocket
cost of alternative travel modes relative to automobile travel.  Examples include
transit fare/pass subsidies, parking costs, or other financial incentives.

4. Employer Support Programs - Includes support programs for carpooling, vanpooling,
transit, and/or bicycling that do not result in any changes in direct travel time or cost
changes.  For example, employers might provide information about ridesharing and
transit opportunities, match employees with carpools or vanpools, and offer
guaranteed ride home programs.

5. Alternative Work Schedules - Includes flex time, telecommuting, staggered work
hours, and/or compressed work weeks.

NOTE: If you are planning to enter your own estimate of final mode
shares as described in the Local Data inputs in Section 3.2,
COMMUTER will ignore any TCM programs you have selected on
the Scenario Information Input screen and will delete your
checkmarks from those selection boxes.  By inputting your own final
mode shares, you are bypassing COMMUTER’s final mode share
calculations that are based on TCM screen inputs.

3.2  Local Data

Once you have provided the general information on the scenario you are analyzing, you need
to provide data on the existing travel behavior and characteristics of the area or site.  Because
travel characteristics such as mode shares (for example, transit users) and average travel
distances can vary a great deal within a region, you should define separate geographic areas
that have distinct and more or less homogenous characteristics for analysis.  For example,
you may wish to conduct separate analyses for the central business district (CBD) and for the
non-CBD portions of a city.  

Baseline (i.e., existing) travel data for the region of interest are entered in the Local Data
input screen, shown in Figure 6.  Each of the data elements in this screen is discussed
following Figure 6.
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LOCAL DATA

Use
Baseline (Existing) 

Data
Default Local Default

Work-Trip Mode Shares Supply Final Mode Shares?
Auto - Drive Alone 75.4%
Auto - Carpool 13.2%
Vanpool 0.5%
Transit 5.3%
Bicycle 0.4%
Walk 4.0%
Other 1.1%
Total 0.0% 100.0%

Work Trip Length (mi)
Average person-trip length 11.4
Average trip length -- vanpool 17.7
Average trip length -- bicycle 1.8
Average trip length -- walk 1.0

Vehicle Occupancy
Average Carpool Occupancy 2.2
Average Vanpool Occupancy 6.0

Length of Peak Period (hours) 3.0
Percent of Work Trips in Peak Periods 61.4%

Baseline mode share, trip length, average occupancy and peak period data representing local conditions are entered in this 
input screen.  From these inputs and data entered in the "Mode Choice Model Coefficients" screen, the COMMUTER model 
internally calculates final mode shares and travel changes resulting from TCM programs selected.  If you want to supply your 
own estimates of final mode shares (such as might be obtained from employee survey data), mark the box labeled "Supply 
Final Mode Shares" (with an "X").  When this option is selected, the COMMUTER model displays an additional series of input 
cells below the box where final mode share inputs can be entered.  Remember, these final mode shares should reflect work-
trip mode choice after implementation of the TCM programs you're currently analyzing and override the mode share 
calculations made by the model.

The peak period includes the morning and evening time periods when highways are most congested.  These periods may be 
defined differently in different areas.  For the default "percent of work trips in peak period" provided, the AM peak is defined as 
6:00 to 9:00 AM and the PM peak as 4:00 to 7:00 PM.  The same peak period should be used for reporting percent of work 
trips in peak period and affected vehicle speeds (which are entered later in the "Other Emissions-Related Data" screen).  

"Length of peak period" refers to the length (in hours) of the AM or PM peak period.  If the AM and PM peak periods are 
different lengths, this can be an average of the two lengths.

"Percent of work trips in peak period" should also be reported as an average for the AM and PM peak periods combined.  For 
example, assume there are 200,000 and 300,000 total vehicle trips in the AM and PM peak periods, respectively.  If the 
number of work trips are 150,000 in the AM peak and 250,000 in the PM peak, then the percentage of work trips in peak period 
is (150,000 + 250,000) / (200,000 + 300,000) = 80%.

Figure 6
Local Data Input Screen

Existing Mode Shares, Trip Length, and Occupancy - If you are conducting a site-specific
analysis, you may be able to obtain data on existing employee mode shares from employee
surveys, if such surveys have been conducted.  You can also enter local data on trip lengths
and average vehicle occupancy for carpools and vanpools if such data are available.  
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If you do not have specific data available, you should be able to obtain transportation data for
the city, metropolitan area as a whole, or other area of analysis from the regional
transportation planning agency.  You should work with local or regional transportation
planners to identify the most appropriate data for the analysis.  

If local data are not available, you may use the default parameters provided in the model. 
These are shown in Figure 6 under the “Defaults” column.  You should indicate which
default values to use by checking the appropriate box(es) on this screen. 

User-Supplied Final Mode Shares - If you are performing an analysis where you have
estimates of “final” mode shares (after implementation of the TCMs being modeled), you can
enter these final mode share estimates in the Local Data screen.  Under most circumstances,
you’ll want to let COMMUTER calculate final mode shares based on the inputs you supply
in the TCM screens using the pivot-point methodology discussed in Section 1.5.  There may
be certain situations where you want to enter your own estimate of final mode shares, rather
than using COMMUTER’s calculations.  For example, when you are performing a site-
specific analysis for a company, you may have employee survey data available that estimate
how mode choice would change in response to a particular program or programs.

For these situations, mark the “Supply Final Mode Shares?” box at the upper right of the
Local Data input screen.  When you do, a series of cells appears below this box, allowing you
to enter final mode shares, reflecting changes from existing shares due to the TCM programs
you’re modeling.  

For example, suppose under existing conditions that “Company A” work-trip mode shares
were split at 80% Auto-Drive Alone and 20% Transit.  Company A is considering a program
in which employees are offered a cash incentive to ride the bus and, from an employee
survey, determines that an additional 5% would accept the incentive and ride the bus.  The
final mode shares are thus split as 75% Auto-Drive Alone and 25% Transit.  These values
would be entered in the final mode share cells after you marked the “Supply Final Mode
Shares?” box.

NOTE:  When you enter your own final mode shares in the Local
Data input screen as explained above, any TCM programs that
you’ve checked at the bottom of the Scenario Information screen are
removed and inputs you’ve entered in those TCM-specific screens
are ignored.  By entering your own final mode shares, you’re telling
COMMUTER not to use the TCM inputs to calculate final mode
shares.
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Under most circumstances, you won’t know what the final mode shares will be as a result of
the TCM programs that you are analyzing.  In these cases, leave the “Supply Final Mode
Shares?” box blank and allow COMMUTER to calculate final mode share from the TCM
program inputs you’ll enter in subsequent input screens.

Length of Peak Period - The “peak period” includes the morning and evening time periods
when highways are most congested.  These periods may be defined differently in different
areas.  You should use the same peak period definition when reporting the percent of work
trips in a peak period that you use when reporting baseline travel speeds  (see below).  You
can obtain information on the peak period definition from transportation planning staff at
your regional transportation planning agency.
 
“Length of peak period” refers to the length (in hours) of the AM or PM peak period.  If the
AM and PM peak periods are different lengths, you should use the average of the two.

Percent of Work Trips in Peak Periods - You need to enter the percent of trips during the
peak periods that are work-related, averaging the totals for the AM and PM peak periods
combined.  For example, assume there are 200,000 and 300,000 total vehicle trips in the AM
and PM peak periods, respectively.  If the number of work trips are 150,000 in the AM peak
and 250,000 in the PM peak, then the percentage of work trips in the peak period is
calculated as follows:

You should enter local or site-specific data if it is available, instead of relying on the default
value. The default value provided is based on the national percentage of all work trips that
occur in both the AM and PM peak periods.  In this program, the default AM peak is defined
as 6:00 to 9:00 AM and the default PM peak as 4:00 to 7:00 PM.

3.3  Edit Coefficients

This screen allows you to enter locally available values for mode-choice travel time and cost
coefficients, rather than use the default values provided by the model.  Figure 7 illustrates the
layout of the Edit Coefficients screen.

Mode-choice coefficients are used within COMMUTER to compute changes in travel of each
commute mode (e.g., drive-alone, carpool, transit, walk, etc.) under Site Access or Transit
Improvement programs and Financial Incentive programs.  These coefficients are used in
transportation models referred to as “logit mode-choice” models to represent the willingness
of commuters to use alternate modes of travel to driving alone when faced with changes in
travel time or cost.  (Please refer to the accompanying COMMUTER Model Procedures
Manual for detailed information on how mode-choice coefficients are developed, tested and
applied in transportation modeling.)
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MODE CHOICE MODEL COEFFICIENTS

Check here to apply local coefficients entered below in "User-Specified" row

DEFAULTS BY AREA SIZE IVTT (min) OVTT (min) Cost (cents)

Metro Area Size All Modes Walk Time
Transit -- 

Wait
Auto - 

Parking
Transit - 

Fare

Large - more than 2,000,000 -0.0281 -0.0521 -0.0584 -0.0094 -0.0065
Medium - 750,000 to 2,000,000 -0.0241 -0.0472 -0.0468 -0.0071 -0.0064
Small - less than 750,000 -0.0207 -0.0373 -0.0563 -0.0065 -0.0038

User-Specified

Coefficients Used: User-Specified

CITY-SPECIFIC DEFAULTS IVTT OVTT Cost

C
he

ck

City Area Size Year All Modes Walk Time
Transit -- 

Wait
Auto - 

Parking
Transit - 

Fare
Albuquerque Small 1992 -0.0209 -0.0219 -0.0978 -0.0031 -0.0031
Boston Large 1991 -0.0314 -0.0330 -0.0550 -0.0173 -0.0083
Chicago Large 1990 -0.0282 -0.0440 -0.0960 -0.0021 -0.0008
Cincinnati Medium 1978 -0.0190 -0.0280 -0.0280 -0.0050 -0.0050
Cleveland Large 1994 -0.0178 -0.0444 -0.0378 -0.0034 -0.0024
Dallas Large 1984 -0.0297 -0.0552 -0.0552 -0.0116 -0.0046
Denver Medium 1985 -0.0180 -0.0540 -0.0282 -0.0095 -0.0044
Detroit Large 1965 -0.0457 -0.0641 -0.1165 -0.0065 -0.0065
Houston Large 1994 -0.0220 -0.0568 -0.0568 -0.0154 -0.0061
Los Angeles Large 1991 -0.0210 -0.0530 -0.0530 -0.0030 -0.0030
Milwaukee Medium 1991 -0.0160 -0.0410 -0.0410 -0.0045 -0.0045
Minneapolis Large 1970 -0.0310 -0.0440 -0.0300 -0.0140 -0.0140
New Orleans Medium 1960 -0.0150 -0.0330 -0.0770 -0.0080 -0.0080
Philadelphia Large 1986 -0.0420 -0.0320 -0.0510 -0.0026 -0.0012
Phoenix Large 1997 -0.0195 -0.0257 -0.0308 -0.0111 -0.0055
Pittsburg Large 1978 -0.0632 -0.1507 -0.1507 -0.0210 -0.0210
Portland Medium 1985 -0.0390 -0.0650 -0.0400 -0.0135 -0.0135
Reno Small 1991 -0.0275 -0.0550 -0.0550 -0.0167 -0.0067
Sacramento Medium 1991 -0.0250 -0.0380 -0.0380 -0.0028 -0.0028
San Francisco Large 1990 -0.0333 -0.0931 -0.0523 -0.0021 -0.0021
San Juan Medium 1990 -0.0366 -0.0717 -0.0752 -0.0066 -0.0066
Santa Cruz Small 1990 -0.0163 -0.0325 -0.0325 -0.0045 -0.0036
St Louis Large 1965 -0.0228 -0.0570 -0.0570 -0.0117 -0.0117
Tucson Small 1993 -0.0180 -0.0400 -0.0400 -0.0018 -0.0018
Wash DC Large 1980 -0.0170 -0.0580 -0.0580 -0.0094 -0.0044

Mode choice model coefficients are entered in this screen.  The program retrieves default coefficients for the metropolitan area 
size input in the Scenario Information screen.  However, these defaults for Large, Medium and Small metropolitan areas are not 
as accurate as city-specific coefficients developed for many communities across the country.   City-specific coefficients for a 
number of cities based on a review of current literature and existing travel demand models are provided for use within the 
model and can be viewed by scrolling down below this help box.  The user is encouraged to utilize these local coefficients for 
the specific city being modeled (if available) in lieu of the area size defaults by simply checking the box next to the appropriate 
city.  The user is also encouraged to contact their local transportation planning agency to ensure the values cited are up-to-date 
or to obtain coefficients for cities not listed in these tables.  

When applying user-specified values, be aware that most models generally use input travel/wait time coefficients in MINUTES 
and cost-related coefficients in CENTS.  Mode choice models such as the TDM model then internally convert the values of 
these coefficients to match the units of the travel/wait time or cost inputs.  The COMMUTER model has also been programmed 
to apply a conversion factor to the Auto Parking and Transit Fare cost coefficients (in cents) when used with financial incentive 
inputs in units of DOLLARS per vehicle per day.  When inputting your own coefficients, make sure the travel/wait time 
coefficients are in MINUTES and the cost-related coefficients are in CENTS.

Figure 7
Edit Coefficients Input Screen
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The travel and emission impacts calculated by COMMUTER are highly sensitive to the
values of these coefficients, especially the cost coefficients.  It is recommended that you use
local coefficients for mode choice, if they are available and up-to-date.  Coefficients have
been estimated in many urban areas by the regional transportation planning agency (usually
MPOs, Councils of Government, or Associations of Governments).  Values of travel time
and cost coefficients for many individual cities are incorporated into COMMUTER at the
bottom of this input screen.  The values of these mode-choice coefficients are based on the
travel models currently used by regional transportation planning agencies.  You are
encouraged to contact your local transportation planning agency to ensure the values cited are
up-to-date or to obtain coefficients for cities not listed in the table at the bottom of the input
screen.  In cases where the survey data underlying the coefficients are more than ten years
old, it is recommended that you use the default coefficients for your area size for estimating
purposes and consult your local planning agency before using the city-specific coefficients.

###



* As noted in Section 2, however, you will not obtain accurate results by analyzing individual measures
and then summing the results.  Measures that may be implemented together should be analyzed together.
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4.  TCM-SPECIFIC DATA

This section discusses the input screens that are used to enter TCM-specific data for each of
five different types of programs, with each program having its own input screen.  As
explained in Section 2, programs can be analyzed individually or in combination.*  At this
stage, you can edit any of the programs checked under “Programs Analyzed” on the
“Scenario Information” screen.  (Remember, however, that if you did not select a program
from the Scenario Information screen, you will not have access to the data entry screen for
that program.) 

4.1  Site Access and Transit Service Improvement Programs

This section describes the Site Access and Transit Service Improvement program inputs.
Figure 8 shows the single input screen used for these programs.

Site Access Improvements
 
Site access improvements include such things as preferential parking policies for carpools
and vanpools or improvements to the work site or area that make access to transit easier.  For
example, parking spaces in close proximity to both office building locations and transit
station/transit center locations could be provided for ease of access and reduced travel times
for carpool and vanpool vehicles.  These programs also include improved pedestrian and
bicycle infrastructure at transit locations to encourage transit usage.  Along with preferential
parking spaces, infrastructure improvements could include secure lockers and showers for
pedestrians and bicyclists and improved access to transit facilities from the adjacent roadway
system.
  
Walk-Access Time - You will need to specify the change in “walk access time,” which is the
time required to walk from the parking space or transit stop to the work site.  A decrease in
walk access time for any particular travel mode is represented as a negative value.  
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SITE ACCESS & TRANSIT SERVICE IMPROVEMENTS

I. Site Access Improvements

Mode:

Change in 
Walk Access 
Time (min)

Drive Alone
Carpool
Vanpool
Transit
Bicycle
Pedestrian

Employer Participation Rate:

II.  Transit Service Improvements

IIa.  More Frequent Service
Change in avg. headway (min)
Employment Served

IIb. Faster Service 
Change in route travel time (min)
Employment Served

Transit Operating Data
Increase in daily VMT by Transit 
Vehicles
Average speed of affected transit 
vehicles (mph)
Default average speed 19.6
Check here to use default transit 
speed

"Change in Walk Access Time" represents the difference in walking time associated with travel to or from the workplace 
as a result of worksite access changes.  Walking time includes the time taken to walk from a parking lot or a bus stop to 
the actual worksite. Walk access time can be affected through policies such as preferential parking for carpools and 
vanpools or through improvements to the worksite or area which make access to transit easier.  A decrease in walk 
access time for any particular mode should be entered as a negative value.  

"Employer participation rate" refers to the percent of employers in the analysis area implementing the walk access 
improvements.  (This option is not necessary for site-specific analysis because the "participation rate" is 100%.) 

"Change in average headway" refers to the average change in frequency of service for transit service to the employment 
center or analysis area.  An increase in service frequency is entered as a negative number.  For example, if peak period 
transit service frequency increases from 20-minute to 15-minute intervals, the change in average headway would be 
entered as "-5.0". 

"Change in route travel time" refers to the average change in total route travel time for all transit service to the area.  A 
decrease in travel time is entered as a negative number.  For example, if new express bus service decreases the overall 
route travel time by 5 minutes, this would be entered as "-5.0".

"Employment served" refers to the percent of employment in the analysis area which is served by the improved transit 
service.  (This option is not available for site-specific analysis). 

"Increase in daily VMT by transit vehicles" refers to the additional transit vehicle-miles of travel as a result of the 
improved transit service.  Refer to Section 4.1 of the COMMUTER Model User Manual for guidance on how to calculate 
this parameter.

Figure 8
Site Access & Transit Improvements Input Screen
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Employer Participation Rate - If you specified an area-wide analysis scope, you will also
need to specify the percent of employers in the analysis area implementing the walk-access
improvements.  

Remember, as discussed in Section 3.1, that there are two types of participation rates you
need to consider in setting up the inputs to COMMUTER.  The first type is used in estimating
the affected employment inputs and refers to participation in any of the TCM programs being
modeled.   The second type, the individual program participation rates, are actual model
inputs, and are used to further restrict the “eligibility” of all affected employment to
individual programs, such as Site Access Improvement programs.  Thus, in an area-wide
analysis assuming 100,000 affected employees, a 15% Employer Participation Rate for Site
Access Improvement programs instructs COMMUTER that 15,000 employees (100,000 ×
15%) are eligible or affected by site access improvement strategies.  (Note that the model
assumes a proportional ratio of employers to employees in determining affected employment
for individual programs.) 

The employer participation rate is not used in site-specific analysis because it is assumed to
be 100%.

Transit Service Improvements

Transit service improvements may include providing more frequent bus or shuttle service to
work sites, as well as providing faster transit service through express routes or operational
improvements.  These improvements may also include implementing new route services
resulting from the transit planning process.

If you are analyzing improvements that lead to more frequent service, you will need to enter
the “Change in Average Headway.”  This refers to the average change in the frequency of
transit service to the employment center or analysis area.  An increase in service frequency is
entered as a negative number.  For example, if peak period transit service frequency increases
from every 20 minutes to every 15 minutes, the change in average headway would be
represented as -5.0 minutes.  

“Employment Served” refers to the percent of employment in the analysis area that is served
by the improved transit service.  As with the Employment Participation Rate input for Site
Access Improvement programs, Employment Served should reflect the fraction of all affected
employment that are exposed to the transit improvements.  As an example, expanding transit
service along a single network corridor would affect only the fraction of employment served
by this transit corridor.  Again, you do not need to enter this input if you are conducting a
site-specific analysis.

If you are evaluating faster service improvements, you will need to enter the “Change in
Route Travel Time.”  This refers to the average change in the time required to travel the
total route for all transit service to the area.  A decrease in travel time is represented as a
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negative number.  For example, if new express bus service decreases the overall route travel
time by 5 minutes, this would be represented as -5.0 minutes.

If transit service improvements are implemented, the change in daily transit vehicle-miles as
a result of increased service must also be considered.  For this, you will need to estimate the
following items:

& The number of additional daily bus-trips on each route, for routes on which service is
increased; and

& The total round-trip route length for each route on which service is increased.  

You should be able to obtain information on route-mileage increases from the local transit
agency or you can develop estimates from operating plans for the proposed transit service. 
Estimates of daily mileage increases should take into consideration the distance traveled to
and from the storage/maintenance facility to the beginning/end of the route.  

In addition, an average travel speed for the affected transit service should be estimated. 
This can be done by dividing the total length of each affected route by the time taken to
complete the route.

If transit service improvements are implemented, the change in daily transit vehicle-miles as
a result of increased service must also be considered.  This requires estimating the following
items:

& The number of additional daily bus-trips on each route, for routes on which service is
increased; and

& The total round-trip route length for each route on which service is increased.  

Information on route-mileage increases can be obtained from the local transit agency or can
be estimated from operating plans for the proposed transit service.  Estimates of daily
mileage increases should take into consideration the distance traveled to and from the
storage/maintenance facility to the beginning/end of the route.  

In addition, an average travel speed for the affected transit service should be estimated.  This
can be done by dividing the total length of each affected route by the time taken to complete
the route.

4.2  Financial Incentive and Parking Cost Programs

Financial incentives include any policies that affect how much it costs to travel via a
particular mode.  Some examples of financial incentives are listed below.
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FINANCIAL INCENTIVES AND PARKING COSTS

Change In Daily Cost:

Mode:
Parking Cost 
($/vehicle)

Fare Cost ($/ 
person/RT)

Other 
Financial 
Cost ($/ 

person/RT)

Total Change 
($/ 

person/RT)
Drive Alone -$              
Carpool -$              
Vanpool -$              
Transit -$              
Bicycle -$              
Pedestrian -$              

Employer 
Participation Rate:

"Financial incentives and parking costs" may include higher parking charges for single-occupant vehicles, reduced 
parking fees for carpools or vanpools, transit subsidies such as free monthly passes, or other financial incentives for 
specific modes.  A decrease in cost is entered as a negative number.  For example, provision of a transit pass valued 
at $30 a month would be entered as a change in fare cost of -$1.50 ($30 / 20 days).  The cost change inputs are 
entered on a daily basis.

"Employer participation rate" refers to the percent of employers in the analysis area offering these incentives to their 
employees.  (This option is not required for site-specific analysis because the "participation rate" is 100%.)

Figure 9
Financial Incentives Input Screen

& Increased parking charges, especially for single-occupant vehicles.

& Reduced parking fees for carpools and vanpools.
& Transit subsidies such as free monthly passes.

& Parking cash-out programs.

The Financial Incentive and Parking Cost program input screen is shown in Figure 9.  A
decrease in cost (i.e., an incentive) is entered as a negative number.  Changes in parkin g cost
are entered on a per-vehicle basis.  Changes in other fare costs and other financial costs are
entered based on the change in cost per person per day (i.e., round trip transit fare).

As in other screens, “Employer Participation Rate” refers to the fraction of all affected
employees being offered financial incentives on a percent-of-employers basis.  Like the other
program-specific “employer participation rate” inputs, COMMUTER applies the proportion
of participating employers to determine the fraction of all affected employees being offered
financial incentives.  It is not used for site-specific analysis.
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Two examples are provided below to illustrate how the financial costs should be calculated
and entered.

Sample Calculations for Financial Incentives and Parking Cost Programs:

& If parking costs are increased by $2.00 per day for all types of vehicles, you would
enter +$2.00 for Auto-Drive Alone, Carpool, and Vanpool.  (The model will convert
the costs per vehicle to the costs per person by dividing by the assumed average
vehicle occupancy as identified in “Local Data.”)

& If a transit pass worth $30 per month is provided, you would enter a change in fare
cost of  -$1.50 ($30 divided by 20 days per month).

Note that you enter these cost inputs in dollars per vehicle per day.  COMMUTER  internally
converts the Parking Cost and Transit Fare mode-choice coefficients that you entered in units
of cents in the “Edit Coefficients” screen into dollar units before combining them with the
cost inputs entered in this screen in the mode share calculations.

Parking Cash-Out Programs - Parking cash-out programs are modeled in this input screen by
treating the cash-out payment as a “subsidy” for use of eligible alternative modes.  For
example, if the cash value of the parking subsidy were $60 per month or $2 per day, a current
Single Occupant Vehicle (SOV) user would see no difference in his/her cost to drive (park),
but the transit user would suddenly find it $2 per day cheaper to use transit.  The same logic
applies to all modes that are eligible alternatives, i.e., bike, walk, or ridesharing (if there is no
problem with the cash-out recipient still parking at the site as a carpooler/vanpooler).  In this
example, you would enter -$2 in the “Transit” row and “Parking Cost” column.

So to handle cash-out programs in COMMUTER, you enter nothing for the SOV mode
parking cost, and enter a subsidy for each of the eligible alternative modes.  Note that in the
rideshare case, each passenger receives the full value of the subsidy, unlike where you give a
parking discount to carpools and the savings is split among the number of occupants.

4.3  Site-Specific Employer Support Programs

There are a number of strategies that employers can use that reduce the number of people
commuting to work in single-occupancy vehicles (SOVs), but do not result in measurable
changes in the time or cost of traveling to work.  Research suggests that such “soft”
incentives or support programs can change travel behavior by providing encouragement to
use other modes of travel, informing travelers of alternatives, or removing impediments. 
Examples of this type of strategy include selling transit passes at the work site, providing
rideshare matches, marketing and promoting alternative modes, providing a guaranteed ride
home program, forming and supporting a vanpool, and providing preferential parking for
carpools.  (Note that these types of programs also apply for an area-wide analysis, discussed
in Section 4.4.)
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EMPLOYER SUPPORT PROGRAMS FOR ALTERNATIVE MODES
SITE-SPECIFIC ANALYSIS

Entry Format (check one only):
Specify Program Level
Specify Mode Share Increase

Specify Program Level:

Program Existing New
Carpool
Vanpool
Transit
Bicycle

Specify Mode Share Increase:

Program Existing Increase New
Carpool 0.0% 0.0%
Vanpool 0.0% 0.0%
Transit 0.0% 0.0%
Bicycle 0.0% 0.0%

"Employer Support Programs" include programs such as provision for an on-site transportation coordinator, ridematching, 
transit information, and other actions aside from time and cost incentives which encourage employees to utilize 
alternative modes.  Two entry options are available for site-specific analysis:

(1) Specify existing and new program levels for Carpool, Vanpool, Transit, and Bicycle program support.  A program level 
of "0" represents no program.  Program levels of "1" through "4" indicate varying levels of effort for the programs.  These 
program levels are described in Section 4.3 of the COMMUTER Model User Manual.

(2) Specify an expected mode share increase for each mode.  This increase is added to the baseline mode share as 
specified in the input data.

IMPORTANT: This entry option should not be utilized unless the user has definitive data indicating a likely mode share 
increase as a result of proposed programs.  If a mode share increase is specified, the user should document existing 
support programs and programs to be implemented, along with survey or other data indicating the basis for the mode 
share increase estimates.

"Program Level" and "Mode Share Increase" input options are mutually 
exclusive.  You enter input data for either one or the other based on which 
Entry Format box you check to the left.  See the help box below for an 
explanation of each input.

Figure 10
Site-Specific Employer Support Programs Input Screen

 
Figure 10 shows the input screen for site-specific analysis of employer support programs.  As
shown in the figure, the first thing you need to do is specify the entry format , which refers to
the type of data you will be entering.

For a site-based analysis, it is recommended that you specify existing and proposed program
levels.  These refer to the general level of effort spent on the program (which affects its
effectiveness) and are explained below, along with the codes used for data entry.  They are
defined separately for carpooling, vanpooling, transit, and bicycle commuting.
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As an alternative, you can specify the expected mode share increase.  This expected increase
in each mode of travel is added to the baseline mode share that was specified in the input
data.

CAUTION: You should not use this alternative entry option unless
you have good data indicating that a proposed program will lead
to a likely mode share increase.  If you do specify a mode share
increase, you should document existing support programs and the
programs to be implemented, along with survey or other data that
were used to estimate the mode share increase.

Definition of Program Levels

The impact of employer support programs and strategies varies depending on the level of
effort expended on the program.  The level of program effort is a particularly important data
input because it defines what is actually meant by, for example, a “carpool support” program. 
The program level can vary from 0 to 4, with 0 representing no program and 4 representing a
program of maximum effort.  (These program level definitions will also apply for area-wide
analyses, as discussed in Section 4.4.)  The following program level descriptions are not
requirements for each level, but are intended as suggested guidelines to help you assign a
level designation to the support activities you are trying to model.  Note that preferential
parking or financial incentives offered as part of a support program should be captured on the
Site Access and Transit Service Improvement input screen, and the Financial Incentives and
Parking Costs input screen, respectively.

Carpool Support Programs

Level 0 - no program

Level 1 - includes carpool information activities (tied in with area-wide matching)
and a quarter-time transportation coordinator.

Level 2 - includes an in-house carpool matching service and/or personalized carpool
candidate get-togethers (including information activities) and a quarter-time
transportation coordinator.



* Flexible work schedules as defined under these support programs refers to providing latitude to
employees to accommodate slight variations in arrival/departure to participate in these programs.  This
differs from a formal Flex-Time policy, which is defined and discussed later in Section 4.5.
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Level 3 - includes in-house carpool matching and information services, a policy of
flexible work schedules* to accommodate carpools, and a half-time transportation
coordinator.

Level 4 - includes in-house carpool matching and information, flexible work
schedules, and a full-time transportation coordinator.

Vanpool Support Programs

Level 0 - no program

Level 1 - includes vanpool information activities (tied in with area-wide vanpool
matching and/or third-part vanpool programs), plus a quarter-time
transportation coordinator.

Level 2 - includes in-house vanpool matching services and/or personalized vanpool
candidate get-togethers, and non-monetary vanpool development, plus a
quarter-time transportation coordinator and a policy of flexible work
schedules.

Level 3 - includes in-house vanpool matching services; vanpool development and
operating assistance, including financial assistance, such as vanpool purchase
loan guarantees, consolidated purchase of insurance, and a startup subsidy
(note that such assistance is different from offering financial incentives to use
vanpools); and additional services such as van washing, plus a half-time
transportation coordinator.

Level 4 - includes in-house vanpool matching services; vanpool development and
operating assistance, including major financial assistance, such as employer
purchase of vans with favorable leaseback (or alternative continuing subsidy,
such as free maintenance, free insurance) in addition to startup subsidy;
several additional incentives such as van washing, guaranteed ride home, and
a full-time transportation coordinator and/or personalized vanpool candidate
get-togethers.

Transit Support Programs

Level 0 - no program
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Level 1 - includes a transit information center plus a quarter-time transportation
coordinator.

Level 2 - includes a transit information center and a policy of work hours flexibility to
accommodate transit schedules/delays, plus a quarter-time transportation
coordinator.

Level 3 - includes a transit information center and a policy of work hours flexibility,
on-site transit pass sales, plus a half-time transportation coordinator.

Level 4 - includes a transit information center and a policy of work hours flexibility,
on-site transit pass sales, guaranteed ride home, and a full-time transportation
coordinator.

Bicycle Support Programs

Level 0 - no program

Level 1 - providing on-site bicycle parking (racks or lockers).  

Level 2 - providing bicycle parking (racks or lockers) and shower facilities.

Level 3 - providing secure bicycle parking (storage lockers or indoor storage) and
shower facilities, in conjunction with local infrastructure conducive to
bicycling.  This includes the presence of (a) off-street bike paths, (b) on-street
bike lanes, and/or (c) local streets with light traffic by which cyclists can
access the workplace.  

Level 4 - providing parking, shower, and infrastructure conditions as for Level 3, and
also sponsoring workplace promotional activities.  These activities should
include promoting bicycle commuting, identifying the availability and
location of parking and shower facilities, and providing local bicycle route
maps, along with other activities to encourage bicycle commuting.

Some employer support programs may have combinations of characteristics different than
those shown here.  In this case, you should choose the program level that most closely
represents the actual program being implemented.  

If there is no program level that you feel most closely represents the combination program
being offered, you can specify “combinations” of program levels by running the program for
an area-wide rather than site-specific analysis.  For example, if a carpool program includes all
the elements of a Level 3 program except for flexible work schedules, you may want to
model this program as halfway between Level 2 and Level 3 in terms of effectiveness.  You
can do this by setting the analysis scope to “Area-Wide” and specifying that 50 percent of
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EMPLOYER SUPPORT PROGRAMS FOR ALTERNATIVE MODES
AREA-WIDE ANALYSIS

Percent of Employers Participating -- Existing
Program Level

Program None 1 2 3 4 Total
Carpool 100% 100%
Vanpool 100% 100%
Transit 100% 100%
Bicycle 100% 100%

Percent of Employers Participating -- New
Program Level

Program None 1 2 3 4 Total
Carpool 100% 100%
Vanpool 100% 100%
Transit 100% 100%
Bicycle 100% 100%

"Employer Support Programs" include programs such as provision of an on-site transportation coordinator, 
ridematching, transit information, and other actions aside from time and cost incentives which encourage employees to 
utilize alternative modes.  

For an area-wide analysis, the analyst should specify both existing and new (expected) participation rates (percent of 
employers participating) by program level for each mode.   Program levels of "1" through "4" indicate varying levels of 
effort for the programs which are described in Section 4.4 of the COMMUTER Model User Manual.

Figure 11
Area-Wide Employer Support Programs Input Screen

employers have a Level 2 program and 50 percent have a Level 3 program.  Note that if you
set the employer participation rate at 100 percent for every program being tested, the area-
wide and site-specific analyses will give identical results.

4.4  Area-Wide Employer Support Programs

The discussion in Section 4.3 of the types of employer support programs that may be offered
also applies here.  Although different input formats are used for site-specific and area-wide
employer support programs, the data elements themselves are similar.  Figure 11 shows the
input screen for area-wide analysis of employer support programs.

You should use the definitions of support program levels given in Section 4.3 for area-wide
analyses also.  Be sure to read these definitions before proceeding.

For area-wide analysis of employer support programs, you must specify the percent of
employers participating in each of the program levels and modes. For each mode (carpool,
vanpool, transit, and bicycle), you need to enter the percent of employers in the area
participating at each program level.   The sum of Levels 0 through 4 for each mode should
equal 100%.  Employers who are not participating in any program would be included in the



*  For an area-wide analysis, this will be the percent in the area-wide employment base; for a site-
specific (single employer) analysis, it will be the percent of employees within the firm.
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“Level 0” program level.  Participation rates should be specified for both the base case
(existing conditions) and the proposed program levels being evaluated.

4.5  Alternative Work Schedule Programs

This class of commuter-related TCM strategies is aimed at reducing how often commute trips
are made or shifting the timing of the trip out of the peak hour.  For example, flex-time and
staggered work hour strategies have the effect of merely shifting commute travel to a less-
congested time period. These strategies will not affect the number of overall trips or the
amount of VMT, but they will change the distribution of trips, VMT, and emissions between
the peak and off-peak time periods.  They may also affect overall emissions slightly by
affecting the average speed in the peak and off-peak periods.  Definitions of the various work
schedule programs and their likely impacts are discussed later in this section.

Figure 12 shows the input screen for entering information on alternative work schedules and
telecommuting programs.  As shown, you will first need to choose an entry format  option,
as explained below:

& Eligibility Rate - This indicates the percent of all employees in the analysis system*

who are offered the program.  The model then applies an assumed participation rate
to the total number of employees that are eligible.  Note that the employees eligible
for each alternative work schedule and those not eligible for any strategy must sum
to 100 percent.  In other words, only one alternative work schedule strategy may be
offered to an employee at a time.  This simplifying assumption is used in the manual
and spreadsheet model because employees are unlikely to combine more than one
alternative work strategy at a time (for example, those employees working a
compressed work week are unlikely to be allowed to telecommute on regularly
scheduled work days).  This parameter relates mainly to the logic of applying this
strategy to different employment segments.  For example, manufacturing or retail
employees are not reasonable candidates for participation in telecommuting
programs.  You should consider the characteristics of the employment base you are
analyzing when determining the value to use for this parameter.

& Participation Rate - As an alternative, you can specify existing and expected actual
participation rates for each program.  
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CAUTION: You should not use the “Participation Rate” entry
option unless you have definitive data on the likely participation
rate as a result of proposed programs.  If you do specify the
participation rates, you should document the existing support
programs and the programs to be implemented, along with the
survey or other data that formed the basis for the participation rate
estimates.
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ALTERNATIVE WORK SCHEDULES

Use Data
Default Local Default

Alternative Work Schedule Parameters
Telecommute: Avg. Days/Week 1.8
Flex Time/Staggered Hours:  Percent of trips 
shifted from peak period

Participation Entry Format (check one only):
Specify Eligibility for Participation
Specify Before/After Participation Rates

A. Eligibility for Participation

% Eligible
Program Existing New
Flex Time
Compressed 4/40
Compressed 9/80
Staggered Hours
Telecommute
Not Eligible 100% 100%
Total 100% 100%

B. Participation Rates

% Participating
Program Existing New
Flex Time
Compressed 4/40
Compressed 9/80
Staggered Hours
Telecommute
Not Participating 100% 100%
Total 100% 100%

"Alternative Work Schedules" include the option to allow employees to utilize flex time, compressed work weeks, staggered work hours, or 
telecommuting.  Flex time and staggered hours will have the effect of shifting some trips outside of the peak period, while compressed 
work weeks and telecommuting will have the effect of eliminating some work trips.  Two program entry options are available:

(1) The user can specify the percentage of employees eligible for each program.  Both existing and new levels of eligibility should be 
specified.

(2) The user can specify existing and expected participation rates for each program.

To accomodate instances where employees are eligible for, or participate in multiple programs, the model allows the user to enter rates 
that exceed 100% when summed across all alternative programs.   The model then internally normalizes the rates before using them in 
the travel calculations.  Section 4.5 of the COMMUTER Model User Manual presents an example for this situtation.

IMPORTANT:  Entry option (2) should not be utilized unless the user has definitive data indicating a likely participation rate as a result of 
proposed programs.  If participation rates are specified, the employer/analyst should document existing support programs and programs 
to be implemented, along with survey or other data indicating the basis for the participation rate estimates.

Figure 12
Alternative Work Schedules Input Screen

Definition of Alternative Work Schedule Strategies

Flex-Time - In this policy, employees can adjust their work schedule (based on when they
arrive at and depart from the work site) in order to travel during the off-peak hours, when
there should be less traffic congestion.  COMMUTER assumes a formal Flex-Time policy
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rather than flexible work schedules.  Flexible work schedules are seen as simply allowing
employees who would carpool or take transit to arrive or leave with slight variations in order
to be compatible with the pool/bus schedule.  In contrast, a Flex-Time policy involves
formally moving the time of arrival or departure to a set of consistent work hours that are
different from the employer’s official hours.  This type of policy may actually detract from
employees’ incentive to carpool or take transit as a means of avoiding traffic congestion.  The
only assumed effect of this strategy is to shift the time of the trips, no vehicle trips are
eliminated.

Staggered Work Hours - Under this strategy, employers establish different starting times for
groups of employees in order to avoid having the entire workforce arrive or leave at the same
time.  Some work sites have a large number of employees arriving within a very narrow time
period, so staggering starting hours can help reduce localized traffic problems. This strategy
is also assumed to affect only the timing of the trips, not the number of vehicle trips.

Compressed Work Week - Under this strategy, employees are allowed to reduce the number
of work trips made by working longer hours on fewer days per week.  Options include the
4/40 schedule where 40 hours are worked in 4 days with the fifth day off and the 9/80
schedule where 80 hours are worked in 9 days with the tenth day off.   COMMUTER
assumes that the 4/40 schedule eliminates one round-trip a week (1/5 of a daily trip) and that
the 9/80 schedule eliminates one round-trip every two weeks (1/10 of a daily trip) for each
participating employee. 

Telecommuting - This strategy involves allowing employees to work off-site, usually at home
via telecommunications linkups, one or more days per week.  Telecommuting thus reduces
the demand for travel to the workplace.  This is accounted for in COMMUTER by simply
removing person trips, along with the equivalent number of vehicle trips, from the total
amount of travel.  (A more sophisticated analysis would consider how some of the commute
trips might be replaced by non-work travel.)

###
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5.  EMISSIONS-RELATED INPUT SCREENS

In the final two input screens, you will supply the information that COMMUTER needs to
calculate emission reductions.  (If you are only interested in using COMMUTER to compute
travel impacts, you don’t need to enter any input information these two screens.)

To make this easier, a large matrix of MOBILE5b emission factors was generated for a series
of local conditions and pre-loaded into the program.  (A total of 24 different sets of emission
factors are contained in COMMUTER.)  To use these pre-loaded factors, all that you need to
do is supply a simple set of vehicle fleet characteristics, and COMMUTER will then look up
the appropriate set of MOBILE5b factors and use them to calculate emission reductions from
the TCM programs being evaluated.  Thus, you do not have to supply detailed, locally
generated MOBILE5b emission factors.

If you are an experienced MOBILE5b user, however, and want to use emission factors that
exactly match your local conditions, you can optionally direct COMMUTER to import and
apply your locally generated factors.   (Refer to Section 2.7 for step-by-step details on
generating and properly importing your own MOBILE5b emission factors into
COMMUTER.)

5.1  Fleet Emissions Information

In the first emissions-related input screen, you will provide the data needed for the program
to select the appropriate set of pre-loaded MOBILE5b emission factors or activate the User-
Supplied Emission Factors” option if you want to use your own locally generated MOBILE5b
factors.

Figure 13 shows the layout of this screen.   If you want to use the pre-loaded emission factors
contained in COMMUTER, follow the input requirements under “Using Pre-Loaded
Factors.”  To use your own factors, see “Using Locally Generated Factors.”

Using Pre-Loaded Factors - To use pre-loaded factors, you must select from the available
fleet characteristic options in the MOBILE Scenario section at the top of the screen that best
match your local conditions.  (Leave the “User-Supplied Emission Factors” and “Calendar
Year of User EFs” cells toward the bottom of the screen blank.) 
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FLEET EMISSIONS INFORMATION

Field Data Notes

MOBILE Scenario Inputs
Calendar Year of Analysis Enter either 2000, 2002, 2005, 2010 or 2020
Season S = Summer, W = Winter
I/M Program Type 0 (zero) = none, 1 = Basic I/M, 2 = Enhanced I/M
Fuel Volatility Class B = Class B (Control Rgn 1), C = Class C (Control Rgn 2)

Fuel Control Program
0 = Conventional Gasoline, 1 = Reformulated Gasoline, 2 = Winter 
Oxygenated Fuel

User-Supplied MOBILE Emission Factors
   Mark the box to the left (with an "X") to compute emission reductions

User-Supplied Emission Factors    using alternate MOBILE5b emissions factors instead of the
   pre-loaded factors already contained in the COMMUTER model 

Calendar Year of User EFs    Select the calendar year of the user-supplied emission factors

The "MOBILE Scenario" inputs are used by the program to select a specific set of MOBILE5b emission factors from a 
series of stored tables that best represent local conditions and emission control programs being modeled.  These inputs 
are familiar to MOBILE5b users.  Further clarification of these inputs for users less familiar with the MOBILE5b emission 
factor model is provided below.
Calendar Year - Because new vehicle emission levels continue to decrease with the introduction of each model year, 
current and future vehicle fleet emissions will depend on the calendar year being analyzed.
Season - Enter either S for summer or W for winter.
I/M Program Type - The type of Inspection and Maintenance program, if any, being operated.  Basic I/M refers to a 
program where a simple "no-load" idle or 2500 RPM test is performed.  Enhanced I/M represents programs in which a 
loaded IM240 or ASM test are run on a dynamometer.
Fuel Volatility Class - Under EPA rulemaking related to fuel volatility ("Volatility Regulations for Gasoline and Alcohol 
Blends Sold in Calendar Years 1992 and Beyond, " 55 FR 23658, June 11, 1990), the U.S. has been divided into two 
VOC Control Regions.  Generally speaking, Volatility Class B (Control Region 1) covers the southern U.S.; Volatility 
Class C encompasses the northern states.  If in doubt, contact your EPA Regional Office to identify the correct Fuel 
Volatility Class.
Fuel Control Program - Under the 1990 amendments to the Clean Air Act, certain areas of the country must use 
reformulated gasoline (RFG) beginning in 1995.  This input allows the user to specify whether RFG is being used and to 
include benefits of additional wintertime oxygenate blends beyond the level required under RFG.

NOTE TO MOBILE5b USERS :  The daily temperature profile used by this program is based upon profiles developed by 
EPA as a function of season and fuel volatility class in its analysis of RFG benefits using the Complex Model.  These 
profiles are as follows:  Summer/Class B - 69 to 94 deg F; Summer/Class C - 72 to 92 deg F; Winter (either class) - 39 
to 57 deg F.

The COMMUTER model has been designed to use pre-loaded MOBILE5b emission factors for a defined range of input 
conditions or a set of user-supplied emission factors for specific local conditions.  Before user-supplied emission factors 
can be used, they must be loaded into model using the "Import Emission Factors" command from the File menu.  If the 
box above is marked and no user-supplied factors have been loaded, the model will signal an error when you try to view 
output results.

The "Calendar Year of User EFs" input identifies the specific calendar year factors from the set of user-supplied factors.  
You can load user-supplied emission factors for any number of individual calendar years.  This input allows you to select 
and compute emission impacts for any one of the calendar years for which emission factors were supplied.  If you enter 
a calendar year that doesn't match those in the user-supplied factors, an error is signaled.

Note:  The VMT mixes (percent of travel by vehicle class) contained in the user-supplied emission factors are 
automatically loaded into the model and used in the emission calculations.  If you are computing impacts with user-
supplied emission factors, you cannot change the VMT mix from the "Other Emission-Related Data" input screen.  When 
applying user-supplied emission factors, the VMT mix must be specified in the MOBILE5b runs.  However, you must still 
supply affected vehicle speed and cold start percentage inputs in the "Other Emissions-Related Data" screen, 
regardless of whether pre-loaded or user-supplied emission factors are being used.

Figure 13
Fleet Emissions Information Input Screen
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Each of these “pre-loaded” fleet characteristics inputs is explained below.

• Calendar Year - Since vehicle fleet emission levels change as new technology
improvements are introduced on newer cars, the calendar year that represents the
analysis scenario must be entered.  

You can choose either 2000, 2002, 2005, 2010, or 2020.  If you are interested in an
analysis year between two of those years, the model should be run for both of the
surrounding years (for example, if you are interested in 2008, you should run
analyses for both 2005 and 2010).  You will then need to interpolate the resulting
travel and emission impacts to represent impacts in the year of interest.

When you choose the year, you should keep in mind the time period when the TCM
programs being modeled will actually be implemented.  For example, in evaluating
improved levels of transit service, it may take a couple of years to implement the
service improvements.

  
• Season - The choice of vehicle emission factors is affected by the ambient

temperature, and, in some areas, fuel controls that are imposed only during certain
seasons.  You therefore need to enter the season for the analysis of interest, selecting
either “S” (summer) or “W” (winter).  If you are an air quality planner, you will
generally select summer when evaluating ozone or particulate-related emission
reductions, and winter for carbon monoxide-triggered evaluations.

• I/M Program Type  - The presence of an Inspection and Maintenance (I/M) program
will affect vehicle fleet emissions.  There are three levels of I/M programs for you to
choose from:  

1. None - no I/M program operating in the region being analyzed;

2. Basic I/M - an I/M program where a simple “no-load” idle or 2500 RPM tailpipe
emissions test is performed along with a visual inspection; and

3. Enhanced I/M - I/M programs in which loaded IM240 or ASM emission tests are
conducted on a chassis dynamometer in conjunction with a visual and functional
emission control system inspection.

You should select and enter the level of I/M that most closely matches the type of
program being operated in the analysis area.

• Fuel Volatility Class - You must select either “B” or “C” to represent the gasoline
volatility class of the analysis region.  These have been assigned under EPA’s final
volatility control regulations.2  Under this rulemaking, the U.S. has been divided into
two VOC (volatile organic compound) control regions, each of which has certain
specifications for reformulated gasoline.



* 
Experienced MOBILE5 users should note that the combination of season and fuel volatility class
inputs is used to select the daily temperature profile upon which the emission factors are based. 
These daily temperature profiles as a function of season and volatility class are the same as those
used by EPA in its analysis of reformulated gasoline benefits using the Complex Model.  These
temperature profiles are as follows:

- Summer, Class B - 69(F to 94(F;
- Summer, Class C - 72(F to 92(F; and
- Winter, either class - 39(F to 57(F.

-50-

If you are within VOC Control Region 1, you should enter “B.”  If you are in an area
in VOC Control Region 2, you should enter “C.”*  Generally speaking, volatility
class B (Control Region 1) covers the southern part of the U.S., and volatility class C
encompasses the northern states.  If uncertain about which area the analysis region is
in, contact your EPA Regional Office.

• Fuel Control Program - Under the 1990 amendments to the Clean Air Act, certain
areas must use reformulated gasoline (RFG) beginning in 1995.  This parameter
allows you to specify if RFG is being used in the analysis region and whether effects
of additional wintertime oxygenated blends should be included.  You should select
and enter one of the following values:

0 - for conventional gasoline;
1 - for reformulated gasoline; or
2 - for wintertime oxygenated fuel.

Using Locally Generated Factors - Once you have successfully imported your own locally
generated MOBILE5b emission factors into COMMUTER as described in Section 2.7, you
can direct COMMUTER to apply them in the emission reduction calculations by marking the
“User-Supplied Emission Factors” box (with an “X”) toward the bottom of the screen.  Once
you activate this option, you must then enter the specific calendar year of the emission factors
you’ve imported in the “Calendar Year of User EFs” input cell.  (This input is used to select a
specific calendar year from a set of factors you’ve imported that may encompass multiple
calendar years.  Even if you’ve only imported emission factors for a single year, you must
enter it into this input cell.)
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NOTE: When you activate the “User-Supplied Emission Factors”
option, any entries you may have made in the “MOBILE Scenario
Inputs” cells at the top of the screen are ignored.  In addition, the
vehicle fleet mix that you’ve specific in your locally generated
emission factors file is automatically loaded into the appropriate
cells in the “Other Emissions-Related Data” screen that follows.

5.2  Other Emissions-Related Data

In this final input screen, you will provide additional emission-related inputs that 
COMMUTER will then use in conjunction with the MOBILE5b emission factors discussed
in Section 5.1 to calculate “before TCM” (i.e., existing) and “after TCM” daily emissions for
the vehicle fleet.  It will then determine the resulting emission reductions from the TCMs
being evaluated.  

Figure 14 shows the Other Emissions-Related Data input screen.  Each of the inputs you will
be required to enter is described below.

Vehicle Fleet VMT Mix - The vehicle fleet is composed of eight different classes of
vehicles, which are listed on the screen.  The VMT mix for the vehicle fleet refers to the
percent of the total travel (VMT) that is driven by each of the eight vehicle classes.  The
emission factors in MOBILE5b are based on vehicle class.  COMMUTER will calculate
emissions for the entire vehicle fleet (referred to as the fleet composite emissions) based on
the percentage of VMT in each vehicle class, by weighing the emission factors together
according to the fleet mix input.

If known, you should supply local data on fleet mix for the analysis area in the “Local”
column.  Be sure that the percentages supplied sum to 100.  If they do not, you will see an
error message when you attempt to view, print, or save the analysis results. 

If local data are not available, you can check the boxes in the “Use Default” column to use
the national default fleet mixes obtained from MOBILE5b.  Note that the default fleet mixes
vary by calendar year and season.

As indicated in Section 5.1, if you are using your own locally generated emission factors, the
VMT mix from your MOBILE5b emission factor file is automatically loaded into these input
cells.

Affected Vehicle Speeds - The values you enter here should represent existing average
vehicle speeds in your region.  You should be able to obtain data on average travel speeds
from transportation planning staff at the regional transportation planning agency.  Even if you
are running a site-specific analysis, enter speeds that represent averages for your urban
region.
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OTHER EMISSIONS-RELATED DATA

Use Data
Default Local Default Explanatory Notes

Vehicle Fleet VMT Mix Percentages of total VMT by vehicle type
LDGV - Light-Duty Gas Vehicles
LDGT1 - Light-Duty Gas Trucks 1 To 6,000 lbs GVW (gross vehicle weight)
LDGT2 - Light-Duty Gas Trucks 2 From 6,001 to 8,500 lbs GVW
HDGV - Heavy-Duty Gas Vehicles Over 8,500 lbs GVW
LDDV - Light-Duty Diesel Vehicles
LDDT - Light-Duty Diesel Trucks To 8,500 lbs GVW
HDDV - Heavy-Duty Diesel Trucks Over 8,500 lbs GVW
MC - Motorcycles
TOTAL (must add to 100%) 0.0%

Affected Vehicle Speed (mph) Average speed (mph) of TCM-affected trips
Peak Period Average Speed 34.6
Off-Peak Period Average Speed 39.7

Cold Start Percentages Percent of trips that start "cold"
Baseline - Peak Period 48.0% Peak period trips that start cold
Baseline - Off-Peak Period 40.0% Off-peak period trips that start cold
Eliminated Trips - Peak 48.0% TCM-eliminated peak trips that start cold
Eliminated Trips - Off-Peak 40.0% TCM-eliminated off-peak trips that start cold

Vehicle Fleet VMT Mix
MOBILE5b generates emission factors for each of the eight different vehicle classes listed.  Fleet "composite" emission factors 
are then calculated by weighting these emission factors by the percentage of travel (i.e., VMT) in each vehicle class.  The 
default VMT mixes provided by this program are MOBILE5b national default values.  These defaults are calendar year and 
season specific.  This input is required only when you are using the pre-loaded emission factors.  If user-supplied factors are 
used, the VMT mix is obtained automatically from the MOBILE5b runs and these input cells are ignored.

Affected Vehicle Speed
Vehicle emissions vary with speed.  The values entered here should represent regional network average speeds during the 
peak and off-peak periods.  Default values supplied are based upon HPMS (Highway Perfermance Monitoring System) 
averages compiled by urban area size.   This input must always be entered whether using either pre-loaded or user-supplied 
emission factors.

Cold Start Percentages
Emission factor models address the fact that vehicles have higher emission rates when started "cold" before the catalyst and 
engine are fully warmed up.  In MOBILE5b, trips are defined as either cold starts or hot starts, depending on the time the 
engine was off (referred to as "soak time") prior to the previous trip.  A cold start is defined as any start with a soak time of at 
least 4 hours for non-catalyst vehicles and at least 1 hour for catalyst vehicles.  In MOBILE5b, all other starts are hot starts.  
For example, if the cold start percentage is 80%, the hot start percentage is 20% (100-80).  The user must enter the cold start 
trip percentage of trips for both the baseline trips and for the trips that would be eliminated by TCMs.  Note that separate cold 
start percentages must be entered for both peak and off-peak periods.  This input must always be entered whether using 
either pre-loaded or user-supplied emission factors.

NOTE TO MOBILE5b USERS :  The cold start percentage inputs used by this program should not be confused with the 
operating mode fraction inputs required by MOBILE5.  Those fractions include specification of the amount of stabilized (Bag 2) 
operation.  In this program, the amount of stabilized operation is internally calculated from the start percentage inputs and the 
average trip length.

Figure 14
Other Emissions-Related Data Input Screen



* In most cases, the MPO for a given region is responsible for both transportation planning and emissions
analysis.  The MPO maintains local data related to travel demand, speed, and emissions inventories for
regional planning purposes.  These data are typically available to member agencies (counties, cities, transit
operators) and businesses.  Metropolitan-level emissions inventory data sets generally provide local data on
travel speeds by peak and off-peak periods that are generated from the travel demand modeling process and
used in regional air quality conformity analysis.

**  MOBILE5b users should not confuse the cold start percentage inputs used by this program with the
operating mode fraction inputs required by MOBILE5b.  Those fractions include specifying the amount of
stabilized (Bag 2) operation.  In COMMUTER, the amount of stabilized operation is calculated internally
from the start percentage inputs and the average trip length.
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You will need these values for both peak and off-peak periods.*  Peak period travel speed
should be the average of travel speeds in the AM and PM peak periods, if these values differ. 

CAUTION:  Do not specify travel speeds at a geographic area
smaller than the county level.  Even if you are performing a site-
specific analysis, the speed inputs should reflect average regional
network travel speeds that employees at the site experience driving
to and from work.

You may also choose to use default travel speeds, shown in Table 2, if local data from the
regional MPO are not available.  These default values have been estimated from national
highway data.  Travel speeds will vary depending on metropolitan area size, since larger areas
tend to be more congested.

 

Table 2
Default Speeds (mph) by Area Size

Metropolitan Area Size Peak Period Off-Peak

1 - greater than 2 million 31.8 37.1

2 - 750,000 to 2 million 34.6 39.7

3 - less than 750,000 34.8 39.7

Cold Start Percentages - This refers to the percentage of the vehicles trips that are made
from a “cold” start.**   Vehicles have higher emission rates when started “cold” before the
catalyst and engine are fully warmed up.  Therefore, emission factor models, including
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MOBILE5b, require that trips be defined as either “cold starts” or “hot starts,” depending on
how long the engine has been turned off (referred to as “soak time”) since the previous trip.

A cold start is defined as any start with a soak time of at least four hours for non-catalyst
vehicles (in other words, it has been at least four hours since the vehicle was turned off after
the previous trip); for vehicles equipped with a catalyst, it refers to any start after a soak time
of at least one hour.  In MOBILE5b, all other starts are hot starts.  For example, if the
baseline peak period cold start percentage is 80%, the hot start percentage is 20% (100-80).  

You must supply the percentage of all trips under baseline travel conditions (before
implementation of the TCMs) that are estimated to start cold, estimating this separately for
both the peak and off-peak periods.  (These periods were defined earlier in Section 3.2.) 
Many metropolitan areas that have had to prepare detailed emission inventories have
developed estimates of these percentages.  You should contact the local air quality or
transportation planning agencies for this information

You must also enter the cold-start percentage for the number of trips that would be
eliminated by the TCMs being evaluated, again in both the peak and off-peak periods.  For
example, if 100 trips were being eliminated during the peak period and 90 of those were from
a cold start, the cold start percentage would be 90.  Because “eliminated trip” cold start
percentages are usually not readily available, you may wish to use the default values, as
explained below.  If you do not want to use defaults for this input, you should consider the
types of TCM programs being evaluated and the specific trips that these programs would
eliminate.  For example, door-to-door carpool/vanpool programs are focused on eliminating
morning-evening commute trips, which are almost always (close to 100%) cold start trips.  

If local data are not available, you can use the default values supplied by COMMUTER,
which are based upon instrumented vehicle measurements collected by EPA.  To use the
default values, simply check the boxes in the “Use Defaults” column.

###
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